### TABLE OF CONTENTS

**Formatting** ................................................................................................................................................. 3  
Template, Guidelines, and The Graduate School Website .................................................................................. 3  
Formatting Your Document ............................................................................................................................... 3  

**Preliminary Draft** ......................................................................................................................................... 11  

**Final Submission Requirements** ................................................................................................................. 12  
ProQuest Electronic Submission ......................................................................................................................... 12  
Doctoral Requirements ..................................................................................................................................... 13  
Master’s Requirements .................................................................................................................................... 13  

**General Questions** ....................................................................................................................................... 14  
Registration ..................................................................................................................................................... 14  
General Information ....................................................................................................................................... 15
Template, Guidelines, and The Graduate School Website

Q. Does The Graduate School have a template or any other formatting information?
   A. Yes, we offer a template, formatting workshops, preliminary draft formatting review, and more. Read over the materials provided on the Thesis/Dissertation webpage and download the Formatting Template and the Preparation Guidelines. You are strongly encouraged to attend a formatting workshop or webinar. All information can be found here: http://graduateschool.utsa.edu/current-students/category/thesis-dissertation/

Q. Where can I find the template and what formats are available?
   A. You can locate the template and preparation guidelines on this page: http://graduateschool.utsa.edu/current-students/formatting-requirements/

   The template is available in MS Word and LaTeX/LyX formats.

Q. I am in the Biomedical Engineering joint program. Is there a separate template for me?
   A. Yes, there is a separate MS Word version of the template for Biomedical Engineering students. At this time, there is not a separate LaTeX template for BME students. If you are using LaTeX, please also download the Word BME template and pay close attention to the changes on the Title Page and the Abstract reflecting the joint program.

Formatting Your Document

Q. What is the correct order for my document?
   A. Your document should follow the order below, regardless of your writing style.

   1. Signature page
   2. Copyright (optional)
   3. Dedication (optional)
   4. Title page
   5. Acknowledgements
   6. Abstract
   7. Table of Contents
   8. List of Tables (if tables are present in document)
   9. List of Figures (if figures are present in document)
   10. Body of Text
   11. End Notes (if included in your document)
   12. Appendices (if included in your document)
   13. Bibliography/References/Works Cited
   14. Vita
Q. Where should my appendix/appendices appear in my document?
   A. Appendices come after your last chapter and before the references section, regardless of writing style.

Q. What are the correct margin settings?
   A. The margins for the entire document should be as follows:

   Top: 1.25”  Bottom: 0.75”  Page Numbers: 0.5” from bottom
   Left: 1.25”   Right: 0.75”

Q. How should I format my page numbers?
   A. The best way to make sure your page numbers are correct is to download and use the formatting template provided on our website: http://graduateschool.utsa.edu/current-students/formatting-requirements/

Remember that page numbers should follow these guidelines:

- Page numbers are located in the bottom center of the page, regardless of which writing style you are using.
- There are NO page numbers until the Acknowledgements page.
- The Acknowledgements page is the first page with a page number. It will be lower case roman numerals and typically starts on page iv.
- Page numbers will be in lower case roman numerals from the Acknowledgements page through the List of Figures.
- The first page of your text begins with Arabic numerals, whether it is Chapter One, an introduction, or a preface. This will always be page 1.
- Arabic numerals continue from page 1 through the last page of your references section.
- The Vita page has NO page number.

Q. How do I set up my page numbers in Word?
   A. If you lose the page number formatting that appears in the template, you can set up all page number sections manually. Remember, you will have multiple page number sections (no page numbers, roman numeral page numbers, Arabic numeral page numbers, and the Vita) in your document. The following page includes instructions for setting up all sections of page numbers in your document.

Make sure your page numbers are placed in the bottom center of the page, regardless of your writing style. Page numbers should never appear in a corner of the page.

If you continue to have trouble setting up your page numbers after following the instructions on the next page, please contact the Thesis/Dissertation Officer for guidance.

Continue to the next page for instructions to set up all page numbers.
These instructions are for Microsoft Word. If you are using Word for Mac, menus may be in different locations than in the PC version. For example, Word for Mac users will select the “Insert” menu rather than the Page Layout menu.

**Adding Roman Numeral Page Numbers:**

1. Check to see if you already have a section break in place between the title page and acknowledgements page. Double-click the footer of the title page. If it states “Footer – Section 1” and the header on the Acknowledgements page says “Header – Section 2,” you already have a section break. Skip to step #5 below. If these numbers are the same or if no section number is given (i.e. it just says Footer and Header), you need to create a section break. Continue to the next step.
2. Click on the bottom of the title page (not the footer, just at the bottom after all text).
3. Go to the Page Layout menu. Select Breaks, then Section Break – Next Page. You have now created a section break.
4. Double-click the footer of the acknowledgements page to open it.
5. In the Header/Footer Tools menu, turn OFF the button that says “Link to Previous.” If this button is already turned off, skip to the next step.
6. Add your page numbers. In the Header/Footer Tools menu, go to Page Number. Add page numbers to the bottom center of the page.
7. If necessary, go back to the Page Number option and select “Format Page Numbers.” From here, you can tell your page numbers to be lower case roman numerals and to begin counting at iv.
8. If needed, delete page numbers from the signature page through title page.

**Adding Arabic Numeral Page Numbers (beginning on the first page of your text):**

1. Check to see if you already have a section break in place between the last roman numeral page and the first page of your document text. Double-click the footer of the last Roman numeral page (typically the List of Figures). If it states “Footer – Section 2” and the header on the first page of your text says “Header – Section 3,” you already have a section break. Skip to step #5 below. If these numbers are the same or if no section number is given (i.e. it just says Footer and Header), you need to create a section break. Continue to the next step.
2. Click on the bottom of the last Roman numeral page (not the footer, just at the bottom after all text).
3. Go to the Page Layout menu. Select Breaks, then Section Break – Next Page. You have now created a section break.
4. Double-click the footer of the first page of your text page to open it.
5. In the Header/Footer Tools menu, turn OFF the button that says Link to Previous. If this button is already turned off, skip to the next step.
6. Add your page numbers. In the Header/Footer Tools menu, go to Page Number. Add page numbers to the bottom center of the page.
7. If necessary, go back to the Page Number option and select “Format Page Numbers.” From here, you can tell your page numbers to be Arabic numerals and to begin counting at 1.

**Removing the Page Number from the Vita:**

1. Check to see if you already have a section break in place between the last page of your references section and the Vita. Double-click the footer of the last page of your references. If it states “Footer – Section 3” and the header on the first page of your text says “Header – Section 4” (these numbers may differ from document to document), you already have a section break. Skip to step #5 below. If these numbers are the same or if no section number is given (i.e. it just says Footer and Header), you need to create a section break. Continue to the next step.
2. Click on the bottom of the last page of your references (not the footer, just at the bottom after all text).
3. Go to the Page Layout menu. Select Breaks, then Section Break – Next Page. You have now created a section break.
4. Double-click the footer of the Vita to open it.
5. In the Header/Footer Tools menu, turn OFF the button that says Link to Previous. If this button is already turned off, skip to the next step.
6. Delete your page number.
Q. What font sizes are acceptable?
A. The body of your text should be 12pt. The easiest thing to do is set all text in your document to 12pt; this is recommended. However, you may optionally make exceptions for the following items:

- You may set chapter titles and other main headings at either 12pt or 14pt. If you choose to set main headings at size 14, be consistent: if one main heading is 14pt, all main headings in your document must be 14pt.

- You may set your text at 10pt for endnotes, footnotes, and Table/Figure titles and descriptions. Again, be consistent if you choose to do this. For example, if one table/figure title is 10pt, all table/figure titles must be 10pt.

Q. What type of spacing is required through the document?
A. You may use double spacing or 1.5 spacing throughout the manuscript, but be consistent: use the same spacing throughout.

Quotations, lengthy tables/figures, and footnotes may be single-spaced.

Q. How do I label my tables and figures?
A. Labels should include the word Table or Figure, the number of the table/figure, and the title. Tables are labeled above, while figures are labeled below. The numbering style (Table 1, Table 2, and so forth vs. Table 1.1, Table 2.1, and so forth) will be determined by your writing style.

Examples:

<table>
<thead>
<tr>
<th>Table 1: Title Typed Here</th>
</tr>
</thead>
<tbody>
<tr>
<td>example</td>
</tr>
<tr>
<td>example</td>
</tr>
<tr>
<td>example</td>
</tr>
<tr>
<td>example</td>
</tr>
</tbody>
</table>

Figure 1: Title Typed Here
Q. How do I label tables or figures that continue onto more than one page?

A. When a table or figure continues onto more than one page, the first page should have the main table/figure heading. The second page (and all subsequent pages that the table/figure continues on) should have a “Table X Continued” or “Figure X Continued” label. See below for examples.

*Continuing table example:*

*Continuing figure example:*
Q. How do I format landscape pages in my Word document?

A. For landscape pages, the pagination must stay the same as your portrait-style pages and your margins must be set correctly. Landscape page numbers must be *manually* placed in the portrait page number position.

1. Inserting a landscape page should automatically create a section break. If it does not, follow the instructions for removing the Vita page number (refer to page 5 of this document) to create a section break.
2. Double-click on the footer of the first landscape page. In the header/footer tools menu, turn off the button that says “Link to Previous.”
3. Double-click on the footer of the first portrait-style page that follows your landscape page(s). Turn off the “Link to Previous” button for this page as well. Your sections are now unlinked.
4. Delete the page number from your landscape page(s).
5. Insert a text box and type in the correct page number.
6. In the Text Box Tools menu:
   a. Make sure the text box has no border or fill color.
   b. Click the Text Direction button until your page number is facing the correct direction as seen in the example below.
7. Drag the text box to the left side of the page. Your landscape page and page number should now look like this:

![Example Landscape Page](image)

8. Make sure your margins are correct. Landscape pages will have different margins than portrait-style pages:
   
   Top = 1.25”    
   Left = 0.75”    
   Bottom = 0.75”    
   Right = 0.75”

9. Make sure the next portrait-style page has the correct formatting. Double-check your margins (use the portrait-style margins listed on page 4 of this document) and make sure the page number continues counting correctly.

**Avoiding Landscape Pages:**

One way to avoid the formatting above is to save an image of your table or figure and rotate the image on a portrait-style page rather than rotating the page itself. If you do this, insert your table/figure title in a text box and rotate the text so it faces the same direction as the rotated image. This eliminates the need to adjust margins and manually adjust page numbers.
Q. I have approval from the IRB for my research. Does this need to be included in my document?
   A. Yes. The IRB approval memo should be included in the appendix section. The IRB letter must follow all required formatting guidelines, including a page number at the bottom center and the appropriate margins. The easiest way to include the IRB letter is to insert it into your Word document as an image (either scan the hard copy of the letter or save the PDF as an image file).

   More information on IRB approval is located in the Preparation Guidelines document.

Q. How do I format my signature page?
   A. Your title should be bold, all capital letters, and centered. If more than one line long, it will be in an inverted pyramid format (top line is longest, bottom line is shortest).

   Your committee members’ names should be typed under the signature lines in the format of First Name Last Name, Ph.D. For example: John Smith, Ph.D.

   DO NOT add a name to the last line or in any way alter it – it should read Dean, Graduate School just as it appears on the template.

   An example of a correctly formatted signature page is below:
Q. I have a different number of committee members than what is shown on the template. What do I do?
   A. Add or remove lines as needed.

Q. Should I add the Dean’s name to the bottom line?
   A. NO – do not add the Dean’s name to the bottom signature line. This should read “Dean, Graduate School” as shown on the template.

Q. Is the top line for the chair of my committee or the chair of my department?
   A. The chair of your committee.

Q. On the template, it says “First Name Last Name, Ph.D.” under each line. What does this mean?
   A. This is the format in which you should type your committee members’ names under each line. For example, “Dr. John Smith” is not acceptable; it should be written “John Smith, Ph.D.”

Q. Do I need to have my signature page signed?
   A. No. As of Spring 2014, submitting two printed copies is no longer a final submission requirement. Because of this, your signature page will not be signed and will be uploaded unsigned to ProQuest.

Q. Since signature pages are no longer signed, how is my document approved by my committee?
   A. Doctoral students: Your dissertation is approved by the Certification of Completion of Dissertation Requirements for Doctoral Degree form. This form is one of the required doctoral forms; there is no change to this policy. Your college will route this form to us for the Dean’s signature. This form should be received by The Graduate School no later than the final deadline.

   Master’s students: Your thesis is approved by the Certification of Completion of Thesis Requirements for Master’s Degree form. This form should be signed once you complete your defense. Your College will route this form to The Graduate School for the Dean’s signature. This form should be received by The Graduate School no later than the final deadline.
Q. What is a preliminary draft?
A. A preliminary draft is a rough draft of your thesis or dissertation submitted to The Graduate School for a formatting check. Submitting a preliminary draft to The Graduate School is extremely strongly recommended for all students, regardless of your academic program. Even if you have used the template, you are very strongly encouraged to submit a draft for review. This draft may or may not be 100% complete. It is not necessary to complete your defense before submitting a preliminary draft for a formatting check.

Q. What is the process for submitting a preliminary draft to The Graduate School?
A. The Preliminary Draft Process can be found here: http://graduateschool.utsa.edu/current-students/preliminary-draft/

Q. What is the deadline for the preliminary draft submission?
A. Deadlines are posted here: http://graduateschool.utsa.edu/current-students/deadlines/ Typically, deadlines are posted at least two semesters in advance.

Q. Can I submit a preliminary draft after the preliminary draft deadline?
A. The Graduate School will accept a preliminary draft after the deadline, but please contact the Thesis/Dissertation Officer before turning in a late draft for additional instructions. The Graduate School only guarantees that drafts submitted by the deadline will be reviewed and have an appointment set up in a timely fashion. Appointments are scheduled in the order drafts are submitted, with priority given to drafts submitted by the deadline.

Q. Can I submit more than one preliminary draft?
A. If necessary, yes. This option will be discussed at your preliminary draft appointment.

Q. Can someone else turn in my preliminary draft to the Graduate School?
A. Yes. Your friend/colleague will complete the required drop-off forms for you when submitting.

Q. Can I print my preliminary draft double-sided?
A. No. The preliminary draft should be printed single-sided. This aids in the review process and allows us room to provide notes and corrections.

Q. I need to submit my preliminary draft but do not live in San Antonio. How can I submit my draft?
A. Please email the Thesis/Dissertation Officer for alternate instructions on how to submit your draft if you are not in town. We will be happy to work with you to ensure your formatting is reviewed.

Q. Do I set up a formatting appointment with the Thesis/Dissertation Officer to drop off my preliminary draft?
A. No appointment is needed to drop off your draft at the front desk of The Graduate School. Once you submit your document, it typically takes 2-4 business days to complete your formatting review. When your review is complete, the Thesis/Dissertation Officer will contact you to set up your formatting appointment.
**Final Submission Requirements**

Q. What are the final submission requirements?
   A. The Graduate School has the following requirements:

   1. **ProQuest**: Submit an electronic copy of your thesis/dissertation to the ProQuest website. Your document must be uploaded as a PDF file. More information on ProQuest is available here: [http://graduateschool.utsa.edu/current-students/proquest/](http://graduateschool.utsa.edu/current-students/proquest/)

   2. **Survey of Earned Doctorates** *(doctoral candidates only)*: Complete the online Survey of Earned Doctorates. More information can be found here: [http://graduateschool.utsa.edu/current-students/doctoral-requirements/](http://graduateschool.utsa.edu/current-students/doctoral-requirements/)

   All requirements must be completed **by 5:00 p.m. on the posted final deadline**. If you have questions about the deadlines, please contact the Thesis/Dissertation Officer.

Q. Do I need to submit two printed copies to The Graduate School?
   A. No. As of Spring 2014, the printed copy requirement has been eliminated. The Graduate School and the UTSA Libraries are no longer accepting hard copies for binding/archival. Your ProQuest copy also serves as the UTSA archival copy.

---

**ProQuest Electronic Submission:**

Q. Does it cost anything to submit electronically through ProQuest?
   A. There is no fee to submit your document to ProQuest. Any charges are associated with optional add-ons offered through ProQuest. These include the copyright registration ($55.00), Open Access publishing ($95.00), and bound copies (prices vary). All three of these items are optional.

Q. Should my ProQuest signature page be signed? In other words, do I need to scan a signed copy of my signature page for ProQuest?
   A. No. When you upload electronically through ProQuest, signatures will not appear on the signature page; it will be unsigned, just as it appears on your computer. **DO NOT** include scanned signatures. You will be asked to remove the signatures and re-upload your document with an unsigned signature page.

Q. Is registering the copyright mandatory?
   A. No, registering the copyright is optional. Copyright registration is offered through ProQuest when you submit your electronic copy. You must decide if you are registering the copyright **prior** to submitting your final copies to the Graduate School. If you do register the copyright, the fee through ProQuest is $55.00 and the copyright page from the template must be included in your document. If you choose not to register the copyright, please delete the copyright page from your final copies.

For more information on copyright, please visit ProQuest’s resources page: [http://www.etdadmin.com/cgi-bin/main/resources](http://www.etdadmin.com/cgi-bin/main/resources)
Q. Can I buy bound copies of my thesis/dissertation?
A. Yes, ProQuest offers the option to purchase bound copies for your personal use. This is one of the final options offered to you during the ProQuest submission process. You are not required to buy bound copies, but they are available if you are interested.

Q. Can I purchase personal bound copies through the Graduate School or UTSA?
A. No. The University does not offer personal binding services. If you would like to purchase bound copies for personal use, they are available through ProQuest. This is outside of The Graduate School’s final requirements.

Doctoral Requirements:

Q. What is the Survey of Earned Doctorates?
A. The Survey of Earned Doctorates (SED) is a federal agency survey in which UTSA participates, conducted by NORC for the National Science Foundation and five other federal agencies. The SED gathers information from new doctoral graduates about their educational histories, funding sources, and post-doctoral plans.

Doctoral students must complete the online SED by the final deadline. This is not the survey you complete when you apply for graduation. The link to complete the SED can be found on our website: http://graduateschool.utsa.edu/current-students/doctoral-requirements/

Q. Do you have all of my doctoral forms?
A. In order for doctoral students to be cleared to graduate, we must have all completed doctoral forms on file. You may ask to review your file with the Thesis/Dissertation Officer during your preliminary draft meeting.

Your department is responsible for routing the completed forms through your College and to The Graduate School for the Dean’s signature. More information on doctoral forms is available here: http://graduateschool.utsa.edu/faculty-staff/doctoral-forms/

Master's Requirements:

Q. What is the “Certification of Completion of Thesis Requirements for Master’s Degree”?
A. This is a form that approves your document and must be received by The Graduate School no later than the final deadline. Your college will route the form to us for the Dean’s signature. Should your advisor or department need a copy of the form, they may access it online here: http://graduateschool.utsa.edu/faculty-staff/petitions-and-other-forms/
**General Questions**

**Registration**

Q. Do I need to be enrolled in thesis/dissertation hours during the semester I will defend and submit my final thesis/dissertation?
   A. Yes, you are required to be enrolled in thesis/dissertation hours during the semester you defend and submit your document to The Graduate School.

From the Graduate Catalog:

**Thesis Hours**
Students receiving advice and assistance from a faculty member in the preparation of a thesis must enroll in the appropriate thesis course (if necessary, for multiple semesters) until final approval of the completed thesis has been given and the final copy has been filed with the Dean of the Graduate School.

**Dissertation Hours**
During each semester or term that a student receives advice and/or assistance from a faculty member or supervision by the Dissertation Committee or uses University resources, they are required to enroll in the appropriate dissertation course.

**Common Problems**

Q. I’m not able to defend prior to the final deadline. Will you accept my final thesis/dissertation on the deadline day without a defense?
   A. No, we will not accept a thesis or dissertation without a defense. You must defend before you can submit a final draft of your thesis or dissertation to The Graduate School. We suggest you allow two weeks between your defense and the final deadline to allow time to make any revisions required by your committee.

Q. I need to graduate this semester, but I also need additional time to complete my final document. I won’t be able to meet the final deadline. What can I do about this?
   A. If you need to discuss the deadline, please contact the Thesis/Dissertation Officer before the final deadline to review your situation.

Q. Can you help me distribute personal bound copies to friends/family/my department since I live out of state?
   A. No. You are responsible for distribution and handling of any personal bound copies you choose to order.
General Information

Q. Does the Graduate School read or check the content of my document?
   A. The content is not checked by the Graduate School. The Thesis/Dissertation Officer will check the required formatting for your document.

Q. When should I defend my thesis or dissertation?
   A. The Graduate School recommends that you defend at least two weeks before the final deadline in order to allow adequate time to make revisions. Please work with your committee to schedule your defense.

Q. I cannot make it to your office during business hours. How can I meet with the thesis/dissertation officer?
   A. Please email the thesis/dissertation officer to discuss options for reviewing your document. We are happy to work with you to ensure your formatting is checked.

Q. Where can I find the deadline to apply for graduation?
   A. You can find this deadline on the Graduation Coordination website: http://www.utsa.edu/registrar/graduation.cfm

Q. I submitted my thesis/dissertation to The Graduate School, but my grade is still RP. When will my official grades show?
   A. The Graduate School does not assign grades for your thesis or dissertation. For questions regarding grades, you should contact your advisor or supervising professor. You may also contact the Registrar’s Office at (210) 458-8000.

Q. Do you require appointments, take walk-ins, etc.?
   A. We accept walk-ins, but you are strongly encouraged to email or call ahead to schedule an appointment to ensure the Thesis/Dissertation Officer is available to meet with you.